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FeatureCAM 2013 R3 offers all of the original features of 

FeatureCAM 2013 R2, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. This section 

describes what's new for FeatureCAM 2013 R3 and covers 

four months of development. To see a year's worth of 
development, please also see the What's New topics for the 

previous two releases. 

 What's New in FeatureCAM 2013 R2 (see page 15) 

 What's New in FeatureCAM 2013 R1 (see page 44) 
 

User interface improvements 
FeatureCAM 2013 R3 includes these user interface improvements: 

 Additional help information is available to you in the form of 
pop-up Balloon help (see page 1). 

 

Balloon help 

Starting with the Plunge tab attributes, balloon help will be rolled 

out across FeatureCAM attributes, making it easier and quicker for 

you to understand how a particular attribute works. 

What's New in 
FeatureCAM 2013 R3 
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To display balloon help, hover your mouse pointer over the attribute 
image on the Plunge tab. A balloon help window is displayed 

containing further information, for example: 

 

If you want to disable balloon help, you can deselect Help > Balloon 

Help from the menu. 

 
 

Tooling improvements 
FeatureCAM 2013 R3 includes these tooling improvements: 

 The Never select this tool (see page 3) option is available for more 

milling tool types. 

 You can now set the touch-off point for Rounding Mill (see page 

3) tools at the tip of the tool. 

 There is a new Probing (see page 4) tool group. 
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Never select tool 

In FeatureCAM 2013 R3, the Never select this tool option, that was 

previously available only for End Mill tools, has been added to other 

tool types, such as Twist Drill: 

 

If you select Never select this tool, FeatureCAM does not select the 

tool automatically, but you can choose the tool manually. 
 

2.5D: Rounding Mills — Set touch-off point at tip 

In FeatureCAM 2013 R3, you can set the touch-off point to be the 
tip of the tool instead of the shoulder. 

There are two new options in the Rounding Mill Tool Properties 

dialog: 

 

Tip-To-Shoulder Length — Enter the length between the shoulder 

and the tip of the tool. This length is the same as the arc Radius by 

default, but you can increase it. 
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Touch off at the shoulder — Rounding Mill tools touch off at the 

shoulder by default.  Deselect this option to move the touch-off 
point to the tip of the tool.  

 

 

 

 

 

 

 

 This example shows the default behavior with Touch off at the 

shoulder selected. The toolpath is at the top of the Round feature. 

 This example shows Touch off at the shoulder deselected. The 

tool touches off at the tip. The toolpath is at the bottom of the 

Round feature. 

 This example shows Touch off at the shoulder deselected and a 
Tip-To-Shoulder Length that is double the Radius value. The tool 

touches off at the tip. The toolpath is below the bottom of the 

Round feature. 

 

 

 When Touch off at the shoulder is selected, the Exposed length 

value does not include the tip.When it is deselected, the 
Exposed length value includes the tip length. 

 

New probing tool group 

There is a new Probe tool group in FeatureCAM 2013 R3: 
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The Probe Tool Properties dialog works in a similar way to the other 

tool groups: 

 

Name — Enter a name that identifies the tool. The name must be 

unique among all the tools in the crib. 

Measure — This indicates the units that are used for reporting the 

tool’s dimensions. Select Inches for inch units or deselect it for 

millimeters. 
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 Ball Diameter 

 Stem Diameter 

 Overall Length 

 Shank Length 

 Lower Shank Length 

 Upper Shank Length 

 Taper Length 

 

  

Taper Shank — Deselect this option to have a shank with a constant 

diameter and enter the Shank Diameter instead of Lower Shank Length and 

Upper Shank Length. 
 

2.5D Milling improvements 
FeatureCAM 2013 R3 includes these 2.5D milling improvements: 

 New technology (see page 6) (NT) toolpaths are available for 

finish operations. 
 

NT toolpaths for finishing 

In FeatureCAM 2013 R3, NT toolpaths are available for the Finish 
pass. 
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There is a new NT toolpaths option on the Strategy tab for the Finish 

pass. The Finish bottom and Wall pass options have moved. 

 

Select NT toolpaths and Finish bottom to enable the Stepover menu, 

where you can select one of the NT toolpaths: 
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When using NT toolpaths for the Finish pass, the HSM attributes are 
available on the Milling tab, and work in a similar way to the Rough 

pass HSM attributes: 

 

 
 

3D improvements 
FeatureCAM 2013 R3 includes these 3D milling improvements: 

 Import surfaces (see page 8) (3D LITE) 

 New Finish axial allowance (see page 8) attribute (3D LITE) 

 New Leave axial allowance (see page 9) attribute (3D MX) 

 3D spiral outwards (see page 9) (3D HSM) 
 

Import surfaces (3D LITE) 

You can now import 3D surfaces from .dxf, .dwg, and .iges files if you 

have the 3D LITE product. 
 

Finish axial allowance (3D LITE) 

In FeatureCAM 2013 R3, you can set separate axial and radial finish 

allowance values for the Z-level rough strategy. There is a new 
Finish axial allowance attribute. 
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Finish axial allowance — Enter the amount of axial (XY) material to 

leave on a feature after the Rough pass. If you enter a value for 
Finish axial allowance, the value for Finish allowance is applied to 

radial (Z) material. If you leave Finish axial allowance blank, the 

value for Finish allowance is applied to axial and radial material. 
 

Leave axial allowance (3D MX) 

In FeatureCAM 2013 R3, you can set separate axial and radial leave 
allowance values for the Z-level finish strategy. There is a new 
Leave axial allowance attribute. 

 

Leave axial allowance — Enter the amount of axial (XY) material to 

leave on a feature after the Finish pass. If you enter a value for 
Leave axial allowance, the value for Leave allowance is applied to 
radial (Z) material. If you leave Leave axial allowance blank, the 

value for Leave allowance is applied to axial and radial material. 
 

3D spiral out 

In FeatureCAM 2013 R3, you can make the 3D spiral strategy move 
outwards. Select the new In to out option on the Strategy tab: 

 

 The Continuous spiral and Smoothing options have been 

moved to this tab. 
 

Other important improvements 
FeatureCAM 2013 R3 includes these other important improvements: 
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 The Part Library (see page 10) is available in 64-bit format. 

 There is a new Vertical mill/turn (see page 10) document type. 
 

Part library: 64-bit format 

In FeatureCAM 2013 R3, you can create and export a 64-bit format 
part library. 

The bit-ness of the current library is displayed in the Part Library 

dialog: 

 

When you create or export a part library, the Part Library Format 

dialog is displayed, where you specify a 64-bit or 32-bit part library. 

 

 A 32-bit version of FeatureCAM cannot read a 64-bit part 
library, but a 64-bit part library is faster and recommended. 

 

Vertical mill/turn (TURNMILL, MTT, 5AP) 

FeatureCAM 2013 R3 supports vertical mill/turn machines such as 
Okuma VTM-120YB, Mori Seiki SuperMILLER 400, Mori Seiki 

NMV5000 DBC, Mazak Integrex e-800V II (side spindle), Matsuura 
CUBLEX-25, and DMG FD Series. 
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There is a new Vertical Mill/Turn document type: 

 

When you open a new Vertical Mill/Turn document, two Setups are 
created by default: 

 

 

Setup1 is a turning Setup 

Setup2 is a milling Setup 

 

The new Vertical Mill/Turn option in Stock Properties is automatically 

selected for a Vertical Mill/Turn document, and the Fixture Location 

button is available for the milling part of the document: 

 

There is a new VerticalMillTurnAddin.bas add-in available. Load and 

run the add-in to access these two buttons: 

 

The PostMillTurnSetups  button combines the 

two Setups into a single NC code file. 

The SimTurnMillingSetups  button combines 

the two Setups into one simulation for 3D or 

machine simulation. 

 
 

Import improvements 
FeatureCAM 2013 R3 includes these import improvements: 
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 You can now manage associativity (see page 12) for SolidWorks 

files. 

 The Parasolid kernel has been upgraded (see page 12) to version 

24.1. 
 

SolidWorks: Manage associativity 

In FeatureCAM 2013 R3, it is easier to manage the associativity with 
SolidWorks files. You can now change the .sldprt file name with 

which a FeatureCAM file is associated. 

Right-click the name of the solid in the Part View and select Solid 

Source File from the context menu: 

 

The Solid Source File dialog is displayed: 

 

If the solid source .sldprt file is renamed or moved, you can set the 

new name and/or location here to keep the associativity. Click the 
Browse button to find the source file. 

If associativity is kept, FeatureCAM displays a warning when the 
source file is updated, to ask if you also want to update the .fm file. 

 

Parasolid kernel upgrade to 24.1 

This is a major upgrade of the Parasolid kernel for FeatureCAM, 

which fixes a number of bugs. 
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As a result of the upgrade, there is a new option in FeatureCAM. 

 

In certain cases, the Parasolid kernel does not compute a Stock 

curve correctly. If you have problems trying to compute a Stock 
curve from a Parasolid file, try selecting the Use new stock curve 

finder option on the Misc. tab of Machining Attributes. 

 This option is deselected by default because the alternative 
method is slower. 

 

Turn/mill and 4th-axis improvements 
FeatureCAM 2013 R3 includes these Turn/mill improvements: 

 You can now change the index axis (see page 13) for turn/mill 
and 4th-axis parts. 

 

Turn/mill & 4th-axis: Change index axis 

In FeatureCAM 2013 R3, you can change the index axis for turn/mill 
and 4-axis positioning parts. You no longer need to use the STOCK 

index axis. 
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There is a new Index axis UCS option on the Indexing tab of the 

Stock Properties dialog: 

 

If you create a new UCS, it is available for you to select in the Index 

axis UCS menu. 
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FeatureCAM 2013 R2 offers all of the original features of 

FeatureCAM 2013 R1, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. This section 

describes what's new for FeatureCAM 2013 R2 and covers 

four months of development. To see a year's worth of 
development, please also see the What's New topics for the 

previous two releases. 

 What's New in FeatureCAM 2013 R1 (see page 44) 

 What's New in FeatureCAM 2012 R3 
 

User interface improvements 
FeatureCAM 2013 R2 has a more modern and attractive user 

interface: 

 The background (see page 16) is improved and matches your 

choice of interface style. 

 The Tool Manager (see page 18) and Tool Properties (see page 

19) dialogs have many improvements. 

 There have been various color improvements (see page 20). 

Other user interface improvements include: 

 A new Plunge (see page 22) tab grouping all attributes relating 

to plunging. 

 The machining attributes relating to helical ramping are now in a 
new dedicated Helical Ramp Options (see page 23) dialog. 

What's New in 
FeatureCAM 2013 R2 
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 You can now easily show or hide all features (see page 24) in a 

Setup. 

 There are new buttons available relating to simulation starting 

points (see page 24). 

 You can now zip multiple files (see page 25) relating to the 

current document, ready to email. 
 

Improved background gradient 

The default background gradient has been improved: 

 

If you change the Style of the interface in the Customize Toolbars 

dialog, FeatureCAM asks you if you want to change the background 

color scheme to one that matches: 
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Shaded Grey: 

 

Glass: 
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Tool Manager improvements 

The Tool Manager preview window background now matches the 

background (see page 16) of the graphics area: 

 

When you select a tool, the preview image is now much more 

detailed. It shows the holder and the shank: 

 

If you move your mouse pointer over the image, the tool is 

automatically centered: 

  

 To turn off this setting, right-click on the image and deselect 
Automatic Center Tool from the context menu. 

You can also display a representation of the flutes on end mill tools. 
To do this, right-click in the preview window and select Show Flutes 

on End Mills in the context menu. The display represents the 

number of flutes and the handedness of the tool, for example: 
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2 flutes, 

right-handed 

 

4 flutes, 

right-handed 

 

4 flutes, 

left-handed 

 

 
 

Tool Properties dialog improvements 

The Tool Properties dialog has been improved in FeatureCAM 2013 

R2. 

The tool preview window, now on the left of the dialog, is much 
larger and separate from the tabs so that it is always visible: 

 

The tool holder is now shown in the preview window, by default. To 

hide the tool holder, right-click in the preview window and deselect 
Show Tool Holder in the context menu. 

The tool shank is also now shown. 

The tool, holder, and shank have a dark outline to make them 
clearer. 

You can automatically center the tool in the preview window by 
moving your mouse pointer over the image: 
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 To turn off this setting, right-click on the image and deselect 
Automatic Center Tool from the context menu. 

You can also display a representation of the flutes on end mill tools. 
To do this, right-click in the preview window and select Show Flutes 

on End Mills in the context menu. The display represents the 

number of flutes and the handedness of the tool, for example: 

2 flutes, 

right-handed 

 

4 flutes, 

right-handed 

 

4 flutes, 

left-handed 

 

 
 

Color improvements 

In FeatureCAM 2013 R2, there are new color controls throughout, to 
make the software more appealing. 
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The default Feature and Sub Spindle Operations colors have been 

improved and you can now change the default Tool colors: 

 

There is a new Reset All button in the Default Colors dialog to enable 

you to reset the default color of all items at the same time. 

Any Custom colors that you define are saved in the settings file and 

are available next time you use FeatureCAM. 
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Plunge tab 

In FeatureCAM 2013 R2, the attributes relating to plunging are 
conveniently located together on a new Plunge tab: 

 

Click the Minimum Ramp button to open the new Minimum Ramp 

Distances dialog: 
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When using Helical ramping, click the Helical Options button to open 

the Helical Ramp Options dialog: 

 
 

Helical Options 

The machining attributes relating to helical ramping are now in a 
new dedicated Helical Ramp Options dialog: 

 

To open this dialog, select Helical ramping and click the Helical 

Options button on the Lead/Ramp tab: 
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Show/hide all in Setup 

In FeatureCAM 2013 R2, you can easily show or hide all features in 

a Setup. There are two new options in the context menu for a Setup 
in the Part View: 

 Show All in Setup 

 Hide All in Setup 

 
 

Simulation start point buttons 

In FeatureCAM 2013 R2, there are two new buttons available: 

 Set sim results as starting point 

 Clear starting point 

To add these buttons to a toolbar: 

1 Select View > Toolbars from the menu. 

The Customize Toolbars dialog is displayed. 

2 On the Commands tab, select Simulation in the Categories list. 

The new buttons are available: 

 

3 Drag the icon you want onto the toolbar you want to add it to. 
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File send 

In FeatureCAM 2013 R2, you can zip multiple files relating to the 
current document, ready to email. 

Open the new Send Part Files dialog by selecting File > Send from the 

menu. 

 

Select the files you want to send from: 

Part document — The current .fm file. 

Milling post — The current Milling .cnc file. 

Turning post — The current Turning .cnc file. 

Wire EDM post — The current Wire EDM .cnc file. 

User interface settings — The .ini file containing your user interface 

preferences. 

Select how you want to send the files: 

As individual files — The individual files are attached to a new email. 

As a zip file — The files are zipped and the .zip file is attached to a 

new email. 

Place on desktop — The files are zipped and the .zip file is saved 

to your desktop. 
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Custom setup sheets 

In FeatureCAM 2013 R3, you can create custom setup sheets for 

milling, turning, and turn/mill parts using a new add-in. 

The add-in extracts information from the Part Documentation dialog 

and enables you to take images for each Setup. 

You can use setup sheets to give information to the machine 
operator about the manufacturing, tooling, and toolpaths of a part. 

To load and run the add-in: 

1 Select Options > Add-Ins from the menu. 

The Macro Add-ins dialog is displayed. 

2 Click the Browse  button and browse to the SetupSheet.dll file. 

If you installed FeatureCAM in the default location, the file is at 
C:\Program Files\Delcam\FeatureCAM\Addins\SetupSheet\SetupSheet.dll. 

3 In the Macro Add-ins dialog, in the Add-In Files list, ensure that 
the check box to the left of the SetupSheet.dll file address is 

selected. 

4 Click OK. 

The Utilities toolbar is displayed, containing the SetupSheet  

button. 

5 Click the SetupSheet button to run the add-in. 
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The Setup Sheet Options dialog is displayed: 

 

The Title, Author, Note 1, Note 2, and Comments values are copied 

from the Documentation tab of the Part Documentation dialog and 

you can edit them there. 

You can use this dialog to capture an image for each Setup in the 

current document, as well as an image to represent the whole 
document. 

To capture an image for a Setup, select the Setup name in the 
Setups list and click the Capture Setup Image button to capture the 

current contents of the Graphics window. 

 First run a simulation only for the Setup you want to capture 
by deselecting other Setups in the Part View; then adjust the 

view to show a good orientation of the Setup, and open the 
Setup Sheet Options dialog to capture the image in the 

Graphics window. 

You must use a template to create the setup sheets. Click the 
Browse Template button to find and set the template you want to 
use. There is a template, SetupSheetTemplate.html, in the 

Addins\SetupSheet folder. 

To create the setup sheets, click the Create Setup Sheets button. The 

part is simulated to generate toolpaths and the setup sheet is 

displayed in your web browser. You can save the HTML file from 
your browser. 
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To open the setup sheet in the FeatureCAM Browser, select File > 

Open from the menu and browse to the setup sheet HTML file. 
 

Network database improvements 
FeatureCAM 2013 R3 includes this network database improvement: 

 You can now use Microsoft SQL Server Express (see page 28) for 

your network database. 
 

SQL Server Express now available 

In FeatureCAM 2013 R3 you can use SQL Server for your network 

database. This gives better performance and reliability for your 
network database. There is a new option in the Tool and Material 

Setup dialog: 

 

Microsoft SQL Server 2012 Express is a free edition of SQL Server 

that you may use to host your Delcam tools and materials database 
used by FeatureCAM. It is available in 32-bit and 64-bit editions and 

in these languages: 

 Chinese 

(simplified) 

 Chinese 

(traditional) 

 English 

 French 

 German 

 Italian 

 Japanese 

 Korean 

 Portuguese 

(Brazil) 

 Russian 

 Spanish 
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When using Microsoft SQL Express to host your FeatureCAM tools 

and materials you need a server computer to host the SQL Server 
software and the tools/materials database. This server computer 

should be a different computer from the client workstations where 
users are running FeatureCAM. 

 The database server can host multiple databases. So your 
server can contain several different FeatureCAM tools and 

materials databases, each from different versions of 
FeatureCAM, different departments in your organization, or 

for whatever other reasons you require. Generally this isn't be 
necessary, but it is possible if you need to do this. 

Installation 

1 Pick a computer at your facility that you wish to host the 

FeatureCAM tools and materials database. We'll call this the 
database server. The database server must meet these criteria: 

 It must be running Microsoft Windows. 

 It must be connected to your network. 

 It must be able to run Microsoft SQL Server Express 2012. 

 You can see system requirements at 

http://msdn.microsoft.com/en-us/library/ms143506.aspx 
(http://msdn.microsoft.com/en-us/library/ms143506.aspx) 

2 Find out the hostname of the database server. 

3 Download either the Express (Database Only) or Express with 

Tools from 

http://www.microsoft.com/betaexperience/pd/SQLEXPCTAV2/en
us/default.aspx 

(http://www.microsoft.com/betaexperience/pd/SQLEXPCTAV2/en
us/default.aspx). If your database server is a 32-bit Windows, 

then you'll need to download the 32-bit version of SQL Server 

Express. If 64-bit, then download the 64-bit version instead. 

 The bitness of your download must match the bitness of the 

database server computer, and has nothing to do with the 
bitness of your client workstations. You may download the 

language of your choice. 

4 Install Microsoft SQL Server Express on your database server. 

5 From any client workstation using FeatureCAM 2013 R3, find 
INITDB in the Start menu and run it. 

6 In the Tool and Material Setup dialog, select On a SQL Server and 

enter the hostname of the database server computer as the 
Server Name. 

http://msdn.microsoft.com/en-us/library/ms143506.aspx
http://www.microsoft.com/betaexperience/pd/SQLEXPCTAV2/enus/default.aspx
http://www.microsoft.com/betaexperience/pd/SQLEXPCTAV2/enus/default.aspx
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7 After entering the Server Name, you can select an existing 

database on the database server in the Database Name menu, or 

create a new one. 

8 The first time you run of INITDB you can do one of the following: 

 Initialize a new database with all the default tools. 

 Import tools from another database elsewhere on your 

network 

 Upgrade an existing database to the latest version of 

FeatureCAM and load it with all of the default tooling. 

Subsequent client installations default to this choice. 
 

Simulation improvements 
FeatureCAM 2013 R2 includes these simulation improvements: 

 3D simulation (see page 30) is faster. 

 Round stock (see page 30) is displayed more accurately. 
 

Better 3D simulation performance 

3D simulation performance has been improved in FeatureCAM 2013 
R2. 

The results of the changes made are very dependent on the 
simulation, and also depend to some extent on the graphics card 

being used. However, as a general rule for simple simulations being 
rendered after every cut, the overall speed (including cutting as well 

as rendering) has been improved by 10% to 15%. 
 

For very large tools, performance was often poor because the entire 
tool, often consisting of thousands of facets, was being simulated, 

when only a small portion of it affected the stock. The changes in 
this version mean that 3D simulation will often recognize these 

situations and only carry out simulation with the part of the tool 
that is close to the stock. This can give big performance 

improvements in some situations, and often gives improved quality 

for multi-axis simulations. 
 

Round stock display improved 

In FeatureCAM 2013 R2, you can make the simulation of round 

stock (used by turning and indexing parts) more accurate. 
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There is a new Round Stock tab in Simulation Options which includes 

the new Roundness tolerance attribute. 

 

Roundness tolerance — Reduce the tolerance to make round stock 

appear rounder and less faceted. 

Higher Roundness 

tolerance: 

 

Lower Roundness 

tolerance: 

 

 
 

2.5D improvements 
FeatureCAM 2013 R2 includes these 2.5D improvements: 

 You can automatically avoid fixtures and clamps (see page 31). 

 With 4-axis wrapping, it is easier to program barrel cams (see 

page 33). 

 
 

Automatically avoid fixtures and clamps 

In FeatureCAM 2013 R2, you can automatically clip or trim 2.5D NT 
roughing toolpaths against fixtures and clamps.  

These features are supported: 

 Boss 

 Pocket 

 Side 
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 Face features created with feature recognition (if the plane of the 

face intersects the clamp solids) 

When you select an NT roughing toolpath as the Stepover type on 

the Strategy tab for one of these features, a new Check surfaces 

button is available on the Dimensions tab: 

 

Click the Check surfaces button to open the Select Check Surfaces 

dialog: 

 

Use this dialog to select surfaces you want to use to limit 

machining. 

Check surfaces are surfaces that denote areas that you do not want 

to machine. Select surfaces that are more horizontal than vertical. A 

check surface acts as a boundary up to which milling occurs. 

 If you select a vertical check surface the milling may resume 

on the other side of it if the surface to be milled extends 
beyond the check surface. 

1  Select the surface(s) in the list box or click Pick and select a 

surface with the mouse. To pick additional surfaces, click Pick 

again before selecting each additional surface. 

2 Click OK to return to the Feature Properties dialog. 
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Click OK and Apply to apply your surface selection to the feature 

and return to the Feature Properties dialog.Optionally enter the 

minimum distance that you want to leave around the check 
surface(s), using the new Check allowance attribute on the Milling 

tab for the rough operation: 

 

 
 

4-axis wrapping: Easier programming of barrel cams 

In FeatureCAM 2013 R2, it is easier to program barrel cam features. 
This particular feature uses 4-axis milling and takes a centerline of 

the cam slot, along with the diameter of the follower, and produces 
a toolpath with a tool of a given diameter that may be smaller than 

the follower. When wrapped around the X axis, small Y moves are 
used in conjunction with adjustments to A in order to get the walls 

of the slot to be correct. 
 

3D improvements 
FeatureCAM 2013 R3 has these 3D improvements: 

 All 3-axis finishing operations (see page 33) can now use a stock 

model. 

 There are now advanced stock model settings (see page 34). 
 

All 3-axis finishing operations can use a stock model 

In FeatureCAM 2013 R2, you can use a stock model with all 3-axis 
finishing operations: 
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 Parallel 

finish 

 Z-level 

finish 

 Isoline 

finish 

 2D spiral 

 3D spiral 

 Radial 

 Flowline 

 Between 2 

curves 

 Horizontal + 

vertical 

 Corner 

remachining 

 Pencil 

 Swarf 

 Steep and 

shallow 

The Stock Model option is now available on the Stock tab for these 

operations: 

 

 Stock models are not yet available for 4-axis and 5-axis 

operations. 

Use the new Stock Model Options (see page 34) button to access 

advanced stock model engagement options. 
 

Advanced stock model settings 

In FeatureCAM 2013 R2 there is a new Stock Model Settings dialog 

to control roughing and finishing operations that use a stock model. 
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Access the Stock Model Settings dialog by clicking the new Stock 

Model Options button on the Stock tab, for 3D strategies: 

 

And the Milling tab for 2.5D NT toolpath operations: 
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The Stock Model Settings dialog contains several attributes for 

roughing and finishing: 

 

Stock model rest roughing 

These attributes apply to the rough operation. 

Expand area by — Enter a value to expand rest areas by the 

specified distance (measured along the surface). A negative value 

reduces the size of rest areas. 

Detect material thicker than — Enter a threshold value. FeatureCAM 

ignores rest material that is thinner than the specified threshold. 

Minimum gap length — Enter the gap length, which controls 

fragmentation by replacing gaps shorter than this distance with a 

toolpath segment. A large value reduces fragmentation, but 
increases the length of the toolpath that isn't actually cutting 

material. A small value produces shorter toolpaths but increases the 
number of toolpath lifts.  

A Minimum gap length of 0: 
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A Minimum gap length of the default value: 

 

Stock model engagement for finishing 

These attributes apply to the finish operation. They reduce tool 
wear, improve surface finish, and stop the tool engaging with the 

material excessively. 

Machine stock only — Select this option to limit the toolpaths to 

areas where a minimum amount of stock is being removed from the 
stock model. 

Detect material thicker than — Enter a threshold value. FeatureCAM 

ignores rest material that is thinner than the specified threshold. 

Minimum length removed — Enter a threshold value. FeatureCAM 

ignores toolpath portions that are shorter than this. 

Use depth of cut — Select this option to limit the depth of cut to the 

value you enter. 

 

 
 

Turn improvements 
FeatureCAM 2013 R2 includes these turn improvements: 

 You can control the liftoff angle with a new attribute (see page 

38). 

 You can use an arc to lead in and out (see page 40) for the finish 
pass of a Turn or Bore feature. 

 There is a new reserved word (see page 41) in XBUILD for a 
Transfer feature. 
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Side liftoff angle 

In FeatureCAM 2013 R2, there is a new Side liftoff angle attribute for 

turned Groove features, on the Turning tab: 

 

You can also set its default value for the current document on the 
Grooving tab of Machining Attributes: 

 

This attribute enables you to lift the tool off the part after each 
plunge cut, at the angle you specify. 

 You must also set the Side liftoff dist.attribute. 

Example 

This part has a Groove feature, shown in pink: 
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The default behavior is for the tool to lift off the part at 90 , shown 

by , after each plunge cut. This results in tool contact with the 

uncut material, at , when the tool is retracting at a rapid feed 

rate along the X axis: 

 

You can avoid this by using the Side liftoff dist. attribute, to move 

the tool back along the Z axis , before lifting off. However this 

results in the tool rubbing along the remaining material along the Z 

axis . 

 

Use the Side liftoff angle attribute, in conjunction with the Side liftoff 

dist. attribute to lift the tool off at the specified angle for the 

specified distance , and avoid rubbing the tool along remaining 

material in any direction: 

 

Side liftoff dist and Side liftoff angle are ignored for the retract move 

at the end of the first plunge. The liftoff move is performed at the 

plunge feed rate. If the groove is a round-bottomed groove, then 
liftoff is not used, even when specified. 
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Arc lead-in/out for Turn/Bore feature 

In FeatureCAM 2013 R2, you can use an arc to lead in and out for 

the finish pass of a Turn or Bore feature. This enables you to finish 

large parts in sections. 

There is a new Leads tab for the finish operation of Turn and Bore 

features, with the new Arc in and Arc out options: 

 

 The linear lead options that were previously on the Turning 

tab are now here. 

This example uses Linear in and Linear out: 

 

This example uses Arc in and Arc out: 
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When using Arc in and Arc out with TNR Comp enabled, small linear 

moves are added to the toolpath before the arc in and after the arc 
out. Compensation is turned on during the linear segments: 

 

 
 

XBUILD: New transfer reserved word 

There is a new reserved word in XBUILD: 

<Z-XFER-COORD> is the Z coordinate of the Transfer feature in setup 

coordinates. This takes into account previous bar pulls. 

 For a Cutoff feature with transfer, there is no concept of 

feature location (because the only location is the cutoff 

location). In this case the <Z-XFER-COORD> is assumed to be 

the location of the work piece coordinate system, plus any 

previous bar pulls.  

 
 

Turn/Mill improvements 
FeatureCAM 2013 R3 includes this turn/mill improvement: 

 The OD location (see page 41) for features from curves has been 

reinstated. 
 

OD location for features from curves reinstated 

In FeatureCAM 2013 R2, the OD option has been reinstated on the 
Location tab for turn/mill features from curves. 

This capability was removed from the software long ago, but has 
been missed. Specifically the ability to make a pattern of features 

has been restored, where the object of the pattern is located in the 
XY plane as opposed to in-place, because many users preferred this 

original approach. 
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Import improvements 
 Spatial's InterOp R23 is integrated: 

 Pro/E Reader adds support for Creo 2. 

 UG NX Reader now supports Unigraphics NX 8.0 version files 

 CATIA V5-6 R2013 (R22) 
 

Export improvements 
FeatureCAM 2013 R3 has support for export to CAMplete TruePath. 

 

XBUILD improvements 
There are two new ways to manipulate strings in XBUILD: 

Operator Function Example Result 

InStr([start,

]string1,stri

ng2[,compare]

) 

Returns the 

position of 
the first 

occurrence of 
string2 

within 

string1. 

 String 
indexes 

are 
0-based. 

The 
return 

value 

indicating 
"string 

not 
found" is 

-1. 

[instr 

("abcdef", 

"def")] 

Returns 3.0 



 

FeatureCAM 2013 R3 What's New What's New in FeatureCAM 2013 R2 • 43  

InStrRev 

(string1,stri

ng2[,start[,c

ompare]]) 

Returns the 

position of 
the first 

occurrence of 
string2 

within 

string1. The 

search begins 
from the end 

of the string, 
but the 

position 
returned 

counts from 
the beginning 

of the string. 

 String 
indexes 

are 
0-based. 

The 
return 

value 
indicating 

"string 
not 

found" is 

-1. 

[instrrev("d

efabcdef","d

ef")] 

Returns 6.0 

You can use these new operators, for example, to extract parts of tool 

names. 
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FeatureCAM 2013 R1 offers all of the original features of 

FeatureCAM 2012 R3, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. 

 

General improvements 
These are the most significant general improvements in FeatureCAM 

2013 R1: 

 There is a new selection method. Drag Select (see page 45) 

enables you to select multiple adjacent entities by dragging the 

mouse pointer across the. 

 It is now easier to convert feed and speed (see page 47) values. 

 You can now snap to STL models (see page 49) and also use 
them as clamps (see page 48). 

 Controlling simulation speed is now easier because you can 
lengthen the simulation speed slider (see page 49) on the 

Simulation toolbar. 

 You can do global edits and transforms (see page 54) on a 

Toolpath feature. 

 FeatureCAM now supports the import of Spatial's 3D InterOp R22 

SP2, NX 8 files. 

 There are new options for the Probing add-in (see page 50). 

 There are new reserved words (see page 50) in XBUILD. 

 

What's New in 
FeatureCAM 2013 R1 
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New selection method 

There is a new Drag Select option in FeatureCAM 2013 R1. This 

method enables you to select multiple adjacent entities by dragging 

the mouse pointer across them. 

To enter Drag Select mode, click the Drag Select  button in the 
Select Menu in the Standard toolbar. 

 

Drag Select example 

This example part contains different colored faces and geometry: 

 

The existing selection methods do not work well for this part. 

For example, if you use the Select by Color/Type dialog, you can 

select either the green lines or the gray lines, but not both at the 

same time: 
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If you use a box selection over the lines in a front view, you can't 

select only the lines without selecting some of the surfaces too: 

 

 

Using the new Drag Select option, you can drag the mouse pointer 

over the lines to the left of the stock to select them all: 

 

 

 

Drag Select can save time when selecting adjacent surfaces. With 

the standard Select mode, to select adjacent surfaces, you must use 

a box-select or Ctrl+click each surface. With Drag Select, just move 

the mouse pointer over adjacent surfaces. You can hold down the 
Ctrl key with Drag Select to add non-adjacent surfaces to the 

selection, or after you have released the mouse button, for example 
to change the view of the part. 
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Easier feed and speed unit conversion 

In FeatureCAM 2013 R1, when you override the feed or speed 

value, then change units, FeatureCAM converts the value you 

entered to the new units. This works for milling and turning parts. 

Previously, when you entered an override value, and changed units, 

FeatureCAM returned to the default value for the new units. 

Example 

1 Create a Slot feature and view the F/S tab in the Slot Properties 

dialog: 

 

The recommended speed is entered by default. 

2 Enter a different Speed value. The override box is checked 

automatically. 

 

3 Change the Speed units: 

 

FeatureCAM remembers the override value entered and converts 

it to the new units. Previously, FeatureCAM returned to the 
recommended value when you switched units. 

The Feed value works in a similar way. 

 



 

48 • What's New in FeatureCAM 2013 R1 FeatureCAM 2013 R3 What's New  

Use STL as a clamp for 3D simulation 

In FeatureCAM 2013 R3, you can use STL files as a clamps for 3D 

simulation. 

To use STL files as clamps: 

1 Select the STLs that you want to use in one of these ways: 

 Select the face of an STL (or multiple-select the faces of more 
than one STL) in the Graphics window. If the STLs are not 

already shaded, click the Shade  button to shade them 

first. 

 Select the names of the STLs in the Part View. 

2 Right-click on the selection. 

3 Select Use STLs As Clamp from the context menu. 

 

To see if an STL is used as a clamp or not, right-click it and look at 
the context menu. If there is a check mark next to the Use STLs As 

Clamp menu item, then that STL is currently used as a clamp: 

 

If there is no check mark, the STL is not currently used as a clamp. 

To unset a solid as a clamp, click the Use STLs As Clamp menu item 

with the check mark. The check mark is removed and the solid is no 

longer a clamp. 
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Snap to STL 

In FeatureCAM 2013 R1, you can snap to points on an STL model 
using Snap to Object and Snap to End Point: 

  

 
 

Lengthen Sim Speed slider 

In FeatureCAM 2013 R1, you can increase the length of the 
simulation speed slider on the Simulation toolbar, to make it easier 

to control the speed. 

To do this: 

1 Ensure the Simulation toolbar is displayed. 

2 Select View > Toolbars from the menu. The Customize Toolbars 

dialog is displayed, but you don't need to do anything in the 
dialog. 

3 Click on the Sim Speed slider in the Simulation toolbar and it 

displays a border. 

 

4 Hover over the border at the right of the button and the mouse 

pointer changes to a double arrow icon. 

 

5 Drag the right border out as far as you want. 

6 Click OK to save your changes and close the Customize Toolbars 

dialog. 
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Probing: New options for Probing UDF 

In FeatureCAM 2013 R1, there are new options that you can set 

easily when you start the Probing Add-in. 

After starting the Probing Add-in, the Probing Settings dialog is 

displayed: 

 

Show Overtravel — Select this option to show a representation of the 

overtravel in the preview in the graphics window and during 

simulation. 

Default Tool Name — By default, the add-in looks for a lollipop tool, 

but you can override that here. Enter a tool name. 
 

XBUILD: New reserved words 

 

5-Axis: 

 

<TOUCHOFF-UCS-X> This is the position in X of the touch-off UCS in 

relation to the Stock Axis. 

<TOUCHOFF-UCS-Y> This is the position in Y of the touch-off UCS in 

relation to the Stock Axis. 

<TOUCHOFF-UCS-Z> This is the position in Z of the touch-off UCS in 
relation to the Stock Axis. 

<UCS-XAXIS-X> The X coordinate of the X axis vector of the 

current UCS. 

<UCS-XAXIS-Y> The Y coordinate of the X axis vector of the 

current UCS. 

<UCS-XAXIS-Z> The Z coordinate of the X axis vector of the 
current UCS. 

<UCS-YAXIS-X> The X coordinate of the Y axis vector of the 

current UCS. 

<UCS-YAXIS-Y> The Y coordinate of the Y axis vector of the 

current UCS. 
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<UCS-YAXIS-Z> The Z coordinate of the Y axis vector of the 

current UCS. 

<UCS-ZAXIS-X> The X coordinate of the Z axis vector of the 
current UCS. 

<UCS-ZAXIS-Y> The Y coordinate of the Z axis vector of the 
current UCS. 

<UCS-ZAXIS-Z> The Z coordinate of the Z axis vector of the 

current UCS. 

 

Turn Part Handling feature: 

 

<FEED-DIST> This is the Feed distance value from a Part 

Handling feature in FeatureCAM. 

<GRAB-DIST> This is the Grab distance value from a Part 

Handling feature in FeatureCAM. 

<SUB-FEED> This is the Subspindle feed rate value from a Part 

Handling feature in FeatureCAM. 

<PULL-DIST> This is the Pull distance value from a Part 

Handling feature in FeatureCAM. 

<CUTOFF-TRT> This indicates which turret has the cutoff 
operation.  The values are empty (no cutoff), 

main upper, main lower, sub upper, sub lower. 

<ALREADY-SUP> TRUE if Already Supported is enabled for a Part 

Handling feature in FeatureCAM. 

<LEAVE-SUP> TRUE if Leave Supported is enabled for a Part 

Handling feature in FeatureCAM. 

<TURRET1-LOC> This indicates the Location of turret 1 while the 

sub-spindle is moving, taken from the Transfer 

Turret Control dialog in FeatureCAM. The values 

are None, Home, Escape, or Cutoff Location. 

<TURRET2-LOC> This indicates the Location of turret 2 while the 
sub-spindle is moving, taken from the Transfer 

Turret Control dialog in FeatureCAM. The values 

are None, Home, Escape, or Cutoff Location. 

<TURRET3-LOC> This indicates the Location of turret 3 while the 
sub-spindle is moving, taken from the Transfer 

Turret Control dialog in FeatureCAM. The values 

are None, Home, Escape, or Cutoff Location. 
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<TURRET4-LOC> This indicates the Location of turret 4 while the 

sub-spindle is moving, taken from the Transfer 

Turret Control dialog in FeatureCAM. The values 
are None, Home, Escape, or Cutoff Location. 

<PART-CATCH> TRUE if the Part Catcher option is enabled for a 

Part Handling feature in FeatureCAM. 

<PUSH-PRESS> TRUE if Push/Press is enabled for a Part Handling 

feature in FeatureCAM. 

<OPEN-DWELL> This is the dwell time after opening the spindle, 
taken from the Open dwell attribute value for a 

Part Handling feature in FeatureCAM. 

<CLOSE-DWELL> This is the dwell time after closing the spindle, 
taken from the Close dwell attribute value for a 

Part Handling feature in FeatureCAM. 

<GRAB-TYPE> Returns the Spindle Action value from a Part 

Handling feature in FeatureCAM. 

<MAIN-ANGLE> This is the Main Angle value from a Part Handling 

feature in FeatureCAM. 

<SUB-ANGLE> This is the Sub Angle value from a Part Handling 

feature in FeatureCAM. 

<P-PULL-DIST> This is the distance that the part was previously 
pulled out of the main spindle, before the 

current operation. 

 
 

FeatureMILL 2.5D improvements 
These are the most significant 2.5D improvements in FeatureCAM 

2013 R1: 

 You can now use continuous spiral toolpaths with drill/mill (see 

page 53) rough endmill operations. 

 You can edit multiple segments (see page 54) in Toolpath 

features and transform them. 

 You can now select the Stepover type (see page 54) (including 

Zigzag), for a Face feature created with Interactive Feature 

Recognition. 
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Drill/Mill: Continuous spiral for rough endmill 

In FeatureCAM 2013 R1, there is a new Use continuous spiral option 

in the Drill/Mill Options dialog in Machining Attributes: 

 

And at feature-level, accessed from the Strategy tab: 

 

 You must select one of the Rough with Endmill... options to 

access the new option. 

The option uses the NT Continuous Spiral toolpath technology to 

eliminate nearly all stepovers. 
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Use continuous spiral 

deselected 

 

Use continuous spiral 

selected 

 

You can use Helical ramping with Use continuous spiral, for example: 

 

Traditional spiral toolpaths can produce spikes in tool load, another 
advantage of NT continuous spiral is that the tool load increases 

gradually. 
 

Global Toolpath edits and transforms 

In FeatureCAM 2013 R1, you can edit multiple segments of a 
Toolpath feature on the Toolpaths tab. 

To do this, CTRL+select or SHIFT+select the segments you want to 

edit and right-click the selection to view the context menu. You can 
set the coolant and feed rates for the selected segments. 

You can also transform a Toolpath feature in the same way as other 
features. Select Edit > Transform from the menu or click the 

Transform button on the Standard toolbar. 
 

Zigzag toolpath for Face 

You can now use a Zigzag toolpath for a Face feature. 

To do this, you must create a Face feature using Extract with 

FeatureRECOGNITION. 
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On the Strategy tab, you can select the Stepover type for the Rough 

pass: 

 

Example 

This part has a boss on the top face: 

 

You can avoid the boss by creating the Face feature using 
Interactive Feature Recognition. 

The default toolpath type is 
Spiral: 

This is the same example with 
NT Zigzag selected as the rough 

Stepover type: 
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FeatureMILL 3D improvements 
These are the most significant 3D improvements in FeatureCAM 
2013 R1: 

 There is a new mid-level 3D product: 3D MX (see page 57) and 
the top level 3D product becomes 3D HSM. 

 You can select a specific operation when using a stock model for 

3D roughing. 

 There is a new Bottom up (see page 61) attribute for Z-level 

finishing (requires 3D MX). 

 You can override the default start points (see page 58) for 

certain strategies using a curve (requires 3D MX). 

 The new Area Removal options enable you to remove small 

toolpath segments when using Z-level roughing and finishing 

(see page 63) and to prevent tool damage to non-center cutting 
tools (requires 3D HSM). 

 Cusp control (see page 70) is now available for the Steep and 
Shallow strategy (requires 3D HSM). 

 There is a new Step cutting (see page 66) option that reduces 

terracing for Z-level roughing toolpaths (requires 3D HSM). 
 

Stock model operation 

In FeatureCAM 2013 R1, you can select a specific operation when 

using a stock model for 3D roughing. 
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New mid-level 3D product 

There is a new mid-level 3D product available in FeatureCAM 2013 
R1: 3D MX. 

The top level, traditional 3D product is now called 3D HSM and 

includes all 3D functionality and Feature Recognition. 

The new 3D MX product offers you a 3D product midway between 

3D Lite and 3D HSM. With 3D MX, you can machine multiple 
surfaces, and it includes Feature Recognition. You can also use the 

Z-level finish strategy. 

The main differences between the three 3D products are: 

 

3D Lite 3D MX 3D HSM 

 Single surface 

 Z-level rough 

 Parallel rough 

 Parallel finish 

 Isoline 

 2D spiral 

Everything in 3D Lite, 

plus: 

 Multiple surfaces 

 Feature Recognition 

 Z-level finish 

 Radial 

 Flowline 

 Four-axis 

 Horizontal + 
vertical 

 Between curves 

 Swarf 

Everything in 3D MX, 

plus: 

 Plunge roughing 

 Pencil 

 Remachine 

 Steep and shallow 

 3D spiral 

 You need 3D MX or 3D HSM to use 5-axis Simultaneous. 
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Override default start points (3D MX) 

In FeatureCAM 2013 R1, you can override the default start point(s) 

for these 3D finishing strategy toolpaths, using a curve: 

 Z-level finish (3D MX) 

 Between 2 curves (3D MX) 

 3-axis swarf (3D MX) 

 3D spiral (3D HSM) 

The start point is moved to the projected intersection of the curve 
and the toolpath. 

You can use a curve with multiple segments to set multiple start 
points for a toolpath, and FeatureCAM uses alternating segments to 

set the start points. 

There is a new Start point(s) option on the Milling tab, where you 

enter the name of the curve: 

 

 This attribute applies only to closed toolpaths. 

Multiple start points example 

This example aerospace part has several open and closed areas: 
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This centerline simulation of a Z-level finish toolpath for this part, 

shows the locations of the default start points: 

 

To move the default start points, first create curves that intersect 

the toolpath where you want the new start points to be. 

In the example, the curves are shown in red: 

 

You must use a single curve per toolpath. You can use the Join 

constructor to create one curve from multiple curves. To open the 
Join Curve dialog, select Construct > Curve > From Curve > Join from 

the menu. 
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Select the curves and click the Add  button to add the curves to 
the list in the Join Curves dialog, for example: 

 

Select the Show Preview option to preview the joined curves, for 

example: 

 

If the curves are not listed in the correct order, select the curve you 

want to move in the list and use the Move item up  and Move item 

down  buttons. 

You can also reverse a curve's direction using the Reverse selected 

curve  button. 

Enter a Curve name for the joined curve. 

 Copy the Curve name to the clipboard so that you can paste it 

into the Start point(s) option. 

On the Milling tab for the finishing strategy, select the Start point(s) 

attribute, enter the name of the curve you created and click the Set 

button to save it. 
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Another centerline simulation shows that the start points have 

moved to the intersections of the joined curve with the toolpath, 
and the toolpath is more symmetrical: 

 
 

Bottom up for Z-level finish (3D MX) 

There is a new option for Z-level finishing in FeatureCAM 2013 R1. 

On the Milling tab of the Surface Milling Properties dialog, select the 

new Bottom up option to machine the Surface feature from the 

bottom upwards. 

Deselect the option to machine the feature from the top downwards. 

 

For example, you can use Bottom up to cut this glider mold part: 

 

After a Z-level rough and a 2.5D finish, a Z-level finish strategy is 
used, with Scallop height to control the shape of the toolpath. 
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This is a 3D simulation with Bottom up deselected: 

 

This is the previous and default behavior. 

The Ball End Mill tool (shown in yellow) starts at the top in the 
middle cutting outwards and so is cutting with the center of the 

tool: 

 

This is the result with Bottom up selected: 

 

The tool starts at the bottom outside of the slope and mills upwards 
and inwards towards the center so that the side of the tool is used, 

which has a better cutting surface. 
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Z-level rough area filter (3D HSM) 

In FeatureCAM 2013 R1, you can remove small toolpath segments 

when using the Z-level roughing and finishing strategies, to prevent 

tool damage when using non-center cutting tools. 

There is a new Area Removal section on the Strategy tab of the 

Surface Milling Properties dialog: 

 

Remove unsafe areas — This removes small toolpath segments to 

prevent tool damage when using non-center cutting tools. When 
machining into small pockets, removing small segments stops the 

central, non-cutting underside of the tool from hitting 
non-machinable material. Unsafe segment removal filters out the 

machining of confined areas with small movement of the cutting 
tool. 

Remove area less than — This removes segments that are smaller 

than the entered percentage of the tool's diameter, unless they 
surround a Boss feature. 

Closed areas only — Select this option to remove segments, in 
enclosed areas, that are smaller than the Threshold value. 
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Z-level rough area removal example 

This headlamp mold has a couple of cavities that work their way 

down into very small pockets: 

 

This is a cutaway view of a 3D simulation with Remove unsafe areas 

deselected: 

 

This is the previous and default behavior. 

The bottom of the pockets are barely bigger than the tool diameter, 

and the tool hardly moves in these areas. The non-center cutting 
region of the tool can't cut the material at the very bottom of the 

pockets. 

This is the simulation with Remove unsafe areas selected and 

Remove area less than set to 80 % of the tool diameter: 

 

The two smaller pocket regions are removed from the toolpath. This 
protects the tool and prevents damage. 
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Z-level finish area removal example 

This cavity part has a small pocket (shown in red): 

 

After using a Z-level rough on the part, this is a cutaway front view 
of a 3D simulation of a Z-level semi-finish with Remove unsafe areas 

deselected: 

 

This is the previous and default behavior. 

The bottom of the pocket is barely bigger than the tool diameter, 
and the tool hardly moves in this areas. The non-center cutting 

region of the tool can't cut the material at the very bottom of the 

pocket. 

This is the simulation with Remove unsafe areas selected and 

Remove area less than set to 80 % of the tool diameter: 

 

The small pocket region is removed from the toolpath. This protects 

the tool and prevents damage. 
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Step cutting (3D HSM) 

You can now reduce terracing when creating Z-level roughing 
toolpaths with large stepdowns, using the new Step Cutting option. 

There is a new Remachining button on the Strategy tab: 

 

Click the Remachining button to open the Z-Level Rough Remachining 

Options dialog. 

 

Select Step cutting to enable step cutting. 

This option machines the terraces that would otherwise remain in a 
Z-level rough toolpath, with the same tool in the same toolpath. The 

terraces are machined from bottom to top. FeatureCAM increases 
the feed rate of the intermediate slices as the depth of cut gets 

progressively smaller, which enables a constant volume removal 
rate. 
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A Z-level rough toolpath with no remachining: 

 

The same toolpath with step cutting: 
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The main slices extend over the whole part, but the step-cutting 

slices extend only as far as they are needed to remove terracing. 

 

 The first pass is a main slice. 

 The next pass is the lowest step-cutting slice. 

 The next pass is the next to lowest step cutting slice and so on 

up the part (shown by ) until the previous main slice is reached. 

 The next main slice. 

The main slices are cut from top to bottom as normal. The 

intermediate slices are cut from bottom to top. This is possible 
because the depth of cut is always less than the depth of cut (or 
Stepdown) for the main slice. This is the most efficient way of 

cutting the part as it reduces the number of passes and increases 
the depth of cut of each pass. 

The attributes available to control step cutting are: 

Stepup — Enter the distance between intermediate cutting levels. 

 

 Stepdown of the main slice. 

 Stepup of the intermediate slice. 

The main slice clears the majority of the material. The intermediate 

slices remove the terraces remaining after the main slice.  

Detect material thicker than — Enter a threshold value. FeatureCAM 

ignores rest material that is thinner than the specified threshold. 
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Expand area by — Enter the distance by which to expand the rest 

areas, measured along the surface. Use with the Detect material 

thicker than value to reduce the areas to be machined to the details 

(for examples, corners), and then to offset these areas slightly to 

ensure that all the detail (for example, on the corners) is machined. 

 

 — model 

 — thickness 

 — true rest material (outlined in pink) 

 — actual rest material detected (blue hatched area) 

 — amount you need to expand the area by to include all the rest 

material 

 — undetected material (black area) 

 — tool 

 — reference tool 

Use the Expand area by option to increase the rest area (the blue 

hatched area) and eliminate the undetected area (the black area). 

Increase feed on intermediate steps — Select to increase the Feed rate 

of the intermediate slices. Because the stepdown of the 

intermediate slices is less than that of the main slice, you can 
increase the feed rate of the intermediate slices while maintaining 

the tool load. Each intermediate slice can have an increasing feed 
rate as the depth of cut gets progressively smaller. 

Maximum feed increase (%) — This is the maximum allowable cutting 

feed rate for the intermediate slices as a percentage of the normal 

feed rate. This value must be larger than 100%. A value of 300 

means the cutting feed rate of the intermediate slices can be up to 
three times faster than for the main slices. 
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Cusp control for Steep and Shallow strategy (3D HSM) 

You can now control the Z-level (steep) portion of the Steep and 
Shallow strategy with the Scallop stepover option. Enable Scallop 

stepover to access the Min. Z increment and Scallop height attributes. 

 

With Scallop stepover enabled, spacing of the toolpaths is calculated 

along the surfaces to give a uniform surface finish. These are 
surfaces cut without using Scallop stepover: 

 

This image shows the same surfaces cut with Scallop stepover: 

 

Scallop height — This is the absolute scallop height between passes 

for isoline milling, projection milling finishing passes, and Z-level 

finishing. This distance is measured along the surface and 
represents the maximum cusp height between neighboring passes 

as shown here. 
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 Stepover 

 Scallop height 

Min Z increment — This attribute is used with Scallop height for 

Z-level finish. The Scallop height attribute specifies the the 

maximum cusp height between neighboring passes. However, if the 
calculated value is smaller than the Min. Z increment, it is set to Min. 

Z increment. 
 

5-axis improvements 
These are the most significant 5-axis improvements in FeatureCAM 
2013 R1. 

5-axis positioning (5AP): 

 You can now specify a positive or negative orientation (see page 

72) for 5-axis positioning. 

5-axis simultaneous (5AS): 

 You can override the default start points (see page 74) for 5-axis 
toolpaths. 

 Tool axis options (see page 76) have been added to Pencil, 
Corner Remachine, and Between two curves strategies. 

 A new Smoothing distance (see page 76) option eliminates 

sudden tool changes. 

 You can now smooth the Elevation and Azimuth axes 

independently with tool axis stabilization (see page 79). 

 Existing tool axis options (see page 84) have been improved and 
you have more control when using Lead and Lean. 
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Positive/negative position (5AP) 

In FeatureCAM 2013 R1, you can specify positive or negative 

orientation for 5-axis positioning. 

There is a new option in the Five-Axis dialog in XBUILD: 

 

You can set Positive or Negative as the Preferred orientation of the 

primary rotary axis. 

In FeatureCAM, there is now a 5-axis position menu. As well as 

Standard and Alternate (previous behavior), you can now select Use 

Post Preference, to use the orientation that you set in XBUILD. 

This menu is available in the Machining Attributes dialog: 
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The Setup dialog: 

 

And the Feature Properties dialog: 
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Override default start points (5AS) 

In FeatureCAM 2013 R1, you can override the default start point(s) 

for 5-axis trim and 5-axis swarf toolpaths, using a curve. 

The start point is moved to the projected intersection of the curve 
and the toolpath. You can use a curve with multiple segments to set 

multiple start points for a toolpath, and FeatureCAM uses 
alternating segments to set the start points. 

There is a new Start point(s) option on the Milling tab, where you 

enter the name of the curve: 

 

5-axis start points example 

This example uses a 5-axis swarf and two 5-axis trim strategies. 

 

Viewing a centerline simulation from the top, you can see that the 
default start point for the 5-axis swarf operation is at the lower right 

of the part. 

 



 

FeatureCAM 2013 R3 What's New What's New in FeatureCAM 2013 R1 • 75  

The default start point for the upper trim operation is at the lower 

left: 

 

And the default start point for the lower trim operation is at the 
lower right: 

 

To override the default start points, you must create a curve that 
intersect the toolpaths where you want the new start points to be. 

In this example, the curve is shown in blue: 

 

On the Milling tab for each strategy, select the Start point(s) 

attribute, enter the name of the curve you created and click the Set 

button to save it. 

A centerline simulation of all three operations shows that the start 

points are now aligned along the curve: 
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5-axis options for more strategies (5AS) 

In FeatureCAM 2013 R1, there are tool axis options for Pencil, 

Corner Remachine, and Between two curves strategies. 

The 5-Axis tab is now available for these strategies: 

 

Previously, this tab was available only for Z-level finish, Parallel 
finish, 3D Spiral, Swarf, Isoline, Flowline, Horizontal + Vertical, and 

5-axis trim strategies. 
 

Smoothing distance (5AS) 

In FeatureCAM 2013 R1, there is a new Smoothing distance 

attribute: 
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Smoothing distance eliminates sudden tool axis changes. 

Smoothing distance example 

This example part has a vertical surface, shown in red, with two 
tabs at the top: 

 

This is the surface in more detail: 

 

Using an Isoline strategy, with Tool axis smoothing enabled and a 

Tilt axis of Lean then lead with no Smoothing distance value, the tool 

has sudden changes in direction. For example, it machines the area 
below the first tab in a tilt position: 
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Then returns to a vertical position between the tabs: 

 

Then returns to the tilt position to machine the area below the 
second tab: 

 

With a Smoothing distance value entered that is long enough to 

cover the area between the two tabs, the tool stays tilted when 

machining between the tabs: 
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Tool axis stabilization (5AS) 

In FeatureCAM 2013 R1 you can smooth the Elevation and Azimuth 
axes independently. Stepped stabilization smoothing locks the 

rotary axis movement by maintaining a fixed tool axis as much as 
possible within an angular range. This toolpath results in a series of 

3+2-axis segments with 5-axis transitions between them. The 
transitions can be done on the surface or with a lift. 

There is a new Axis Smoothing tab: 

 

 You must select the Tool axis smoothing option on the 5-Axis 
tab and click the Apply button to display the Axis Smoothing 

tab. 

Elevation — Select how to smooth the elevation angle of the tool 

axis. An elevation of 90  aligns the tool with the Z axis, and an 

elevation of 0  means the tool is in the XY plane. 

None — Select this option to have no smoothing. The tool axis 

orientation moves as and when it needs to move. 

Smoothed — Select this option to enable the tool axis angle to 
change smoothly over the Smoothing distance. The change in angle 

will not be more than the Maximum angular correction unless the 

angle of the unsmoothed toolpath varies by more than the Maximum 

angular correction in less than Smoothing distance. In such regions, 
the angle may change by more than the Maximum angular correction 

to give a smooth result. 
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Stepped on surface — Select this option to enable the tool axis angle 

to change by up to the Maximum angular correction to form steps of 

constant value. To avoid sharp tool axis movements, a smooth 
transition between steps is made starting at the Smoothing distance 

away from the possible ends of adjacent steps. The tool always 
remains in contact with the surface. 

Stepped with links — Similar to Stepped on surface, select this option 

to enable the tool axis angle to change by up to Maximum angular 

correction to form steps of constant value. In this case, the toolpath 

segments are subdivided at the end of each step, and link moves 

are inserted so the tool axis changes when the tool is not in contact 
with the model. This means that tool axis angle of each toolpath 

segment is constant. 

 

 Original toolpath, no smoothing 

 Smoothed toolpath 

 Maximum angular correction limits 

 Azimuth or elevation 

 Toolpath distance 

Maximum angular correction — Enter the maximum angle the 

smoothed axis may deviate from the initial in the elevation 

direction.  Changes in angle will not exceed this value unless the 
angle of the initial toolpath varies by more than the Maximum 

angular correction in less than the Smoothing distance. In such 

regions, the angle may change by more than the Maximum angular 

correction to give a smooth results. 

Azimuth — Select how to smooth the azimuth angle of the tool axis. 

Azimuth is the angle between the X axis and the projection of the 
tool in the XY plane. 

None — Select this option to have no smoothing. The tool axis 

orientation moves as and when it needs to move. 
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Smoothed — Select this option to enable the tool axis angle to 

change smoothly over the Smoothing distance. The change in angle 
will not be more than the Maximum angular correction unless the 

angle of the unsmoothed toolpath varies by more than the Maximum 

angular correction in less than Smoothing distance. In such regions, 

the angle may change by more than the Maximum angular correction 

to give a smooth result. 

Stepped on surface — Select this option to enable the tool axis angle 

to change by up to the Maximum angular correction to form steps of 

constant value. To avoid sharp tool axis movements, a smooth 
transition between steps is made starting at the Smoothing distance 

away from the possible ends of adjacent steps. The tool always 
remains in contact with the surface. 

Stepped with links — Similar to Stepped on surface, select this option 
to enable the tool axis angle to change by up to Maximum angular 

correction to form steps of constant value. In this case, the toolpath 

segments are subdivided at the end of each step, and link moves 
are inserted so the tool axis changes when the tool is not in contact 

with the model. This means that tool axis angle of each toolpath 
segment is constant. 

 

 Original toolpath, no smoothing 

 Smoothed toolpath 

 Maximum angular correction limits 

 Azimuth or elevation 

 Toolpath distance 
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Maximum angular correction — Enter the maximum angle the 

smoothed axis may deviate from the initial in the azimuth direction. 
Changes in angle will not exceed this value unless the angle of the 
initial toolpath varies by more than the Maximum angular correction 

in less than the Smoothing distance. In such regions, the angle may 
change by more than the Maximum angular correction to give a 

smooth results. 

Smoothing distance — Enter the distance over which to smooth the 
tool axis movement. When using Stepped on Surface, or with sudden 

changes in direction in the original toolpath (such as a right-angled 

corner), you get rapid changes of orientation of the tool axis which 
leaves dwell marks. To prevent this, the Smoothing distance blends 

the change in orientation and gives a much improved surface finish. 

 

 Original toolpath, no smoothing 

 Smoothed toolpath 

 Maximum angular correction limits 

 Azimuth or elevation 

 Toolpath distance 

Override smoothing UCS — Select this option to use a different UCS 

to the UCS used to generate the toolpath to define elevation and 

azimuth for smoothing. 

UCS — Select the UCS to use when smoothing. 
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Stepped on surface example 

This car door part uses a trimming toolpath around the edge: 

 

With no smoothing, the rotary table has a rocking motion and 
sudden direction changes can leave witness marks. 

In some areas of the model, it is impossible to avoid the rotation, 
such as when the tool makes its way around the corners and the 

wheel arch. However, it is areas such as on this long edge of the 
door, where the machine table is rocking backwards and forwards, 
that you can avoid this using the Stepped on surface options: 

  

With Stepped on surface enabled for both Elevation and Azimuth, 

with a Max. angular correction of 80, the table does not rotate while 

cutting this area: 
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Stepped with links example 

This example part uses the Pencil strategy to cut the bottom fillet: 

 

Enabling Stepped with links for both Elevation and Azimuth reduces 

the tool movement. 

A centerline simulation shows the links that FeatureCAM inserts 

links so that it can change direction while not in contact with the 
surface: 

 

 
 

Improved tool axis options (5AS) 

The tool axis options on the 5-Axis tab have been improved: 

 

For Use Lead and Lean, you can now select where the lead and lean 

angle is measured from. 
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 Contact normal — Select this option to lead and lean from the 

surface normal at the contact point. 

 Vertical — Select this option to lead and lean from the Setup's Z 

direction. 

 Travel dir — Select this option to lead and lean from the 

perpendicular to the direction of movement 

 Legacy — Select this option to use the lead and lean style used in 

FeatureCAM 2012 R3. 

For Other, the From point, To point, From line, To line, From curve, 

and To curve options are now more accurate. 

 The old options are still available as From point (old-style), To 

point (old-style), From line (old-style), From curve (old-style), and 

To curve (old-style). 
 

FeatureTURN improvements 
These are the most significant Turn improvements in FeatureCAM 
2013 R1: 

 Part transfers are now fully integrated into FeatureCAM with a 
new Part Handling (see page 85) feature. 

 You can control the feed rate (see page 87) on approach moves. 

 You can now recognize a turned profile (see page 91) from an .stl 

file. 

 Canned cycles (see page 90) are now supported for a semi-finish 
pass. 

 

Integrated part handling (TURN) 

Part transfers are fully integrated into FeatureCAM 2013 R1. These 

transfer types are available: 

 Slug transfer 

 Reverse slug transfer 

 Bar pull 

 Part support on 

 Part support off 

Post and simulation are supported. 
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There is a new Part Handling feature in the turn New Feature wizard: 

 

Select Part Handling and click Next to open the New Feature - 

Dimensions page: 

 

Select the type of Part Handling feature you want and enter the 
dimensions. Click Next to open the New Feature - Strategies page: 

 

Set the attributes for the Part Handling feature, for example: 

Part catcher — Select this option if you want to instigate the part 

catcher. 

Already Supported — Select this option to indicate that the part is 

already supported. 

Sub Angle — Enter the angle that you want the sub-spindle to rotate 

to before it moves to collect the part. 
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Click Finish to save the Part Handling feature. 

In the same way as for other features, the Part Handling feature 
name is displayed in the Part View and on the Op List tab, and you 

can edit the feature in the Part Handling Properties dialog: 

 

There is also a new Transfer format type in the XBUILD menu: 

 
 

Control feed rate on approach moves (TURN) 

In FeatureCAM 2013 R1, you can set a start curve as a feed move 

for these operations: 

 Turn 

 Bore 

 Groove 

 Thread 

 Face 

 Drill 

 Cutoff 
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There is a new Feed from start point or curve option on the 

Feed/Speed tab at feature level: 

 

Feed from start point or curve — Select this option to use a feed 

move from the Start point or the end of the Start curve set on the 

Turning tab, to the beginning of the toolpath: 

 Rapid on curve — Select this option if you are using a Start curve 

and want to use a rapid move along it. 

 Selecting Feed from start point or curve and Rapid on 

curve, is the equivalent of selecting the Feed from start 

option on the Turning tab in previous versions of 

FeatureCAM. 

 Feed on curve — Select this option if you are using a Start curve 

and want to use a feed move along it. Enter the feed rate 
value(s). You can set the feed move as a single value, or use a 

comma separator to enter multiple values, for example 200, 100, 

50. If you enter multiple values, the feeds are applied to the 

curve segments in reverse order. So with these values, the last 

segment has a feed rate of 50, the second last has a feed rate of 

100 and any remaining segments have a feed rate of 200. If you 

do not enter any feed rate values, FeatureCAM uses the default 

feed rate. 
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You can also set the default value for this option in Machining 

Attributes, on the Misc. tab: 

 

Start curve as feed move example 

This example turned part has a Turn, Hole, and Groove feature: 

 

A 3D simulation with 3/4 view shows that the tool has to pass 

through a narrow channel to access the Groove feature: 

 

To control the movement of the tool through that narrow channel, 
you can create curves and set them as Start point and End point on 
the Turning tab. 
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A Centerline simulation of just the Groove feature, shows the 

approach move in green, which is a rapid move: 

 

On the Feed/Speed tab, select Feed from start point or curve and Feed 

on curve. Enter the feed value(s) and click Apply. 

The Centerline simulation now shows the approach move in purple, 
a feed move: 

 

 

 
 

Canned cycle support for semi-finish (TURN) 

In FeatureCAM 2013 R1, you can use a finishing canned cycle with a 
semi-finish pass. The Semi-finish pass option is now available when 
the Use canned cycle option is selected, on the Strategy tab: 
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STL curve of revolution recognition (TURN) 

In FeatureCAM 2013 R1, you can recognize a turned profile from an 
.stl file using the Polygonal method: 

 

The Polygonal method uses the simulation engine to triangulate the 

file and create a profile curve, based on the Tolerances set. 

This example balustrade part is an imported .stl file. 

 

With surface shading turned off, you can see the triangles that 
make up the .stl file: 

 

To create the turned profile, select Construct > Curve > From Surface 

> Revolved Surface Boundary from the menu. 

1 In the Revolved Surface Boundary dialog, select Polygonal method. 

2 Optionally click the Tolerances button to change the default 

Triangle tolerance and Arcline approx. tolerance values. 

3 Click the Preview button to see the boundary highlighted in dark 

blue in the Graphics window: 

 

FeatureCAM has found the correct profile height of the revolved 
square ends of the balustrade. 

4 Click OK to create the curve. 

You can use this curve to create a Turn feature. 
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FeatureTURNMILL improvements 
These are the most significant Turn/Mill improvements in 
FeatureCAM 2013 R1: 

 You can now set the tool used on a rotary Surface Milling feature 
to a fixed B angle (see page 92). 

 FeatureCAM now recognizes Hole features (see page 95) from 
imported SolidWorks parts. 

 The Import wizard is now available when importing turn/mill 
solids. 

 You can now use the Y axis with a Points List pattern (see page 
94). 

 

B-axis rotary (TURNMILL) 

In FeatureCAM 2013 R1, there is a new method in B-axis turn/mill 
that enables the tool used on a rotary Surface Milling feature to be 

set at a fixed B angle. 

 To use this method you need the 3D, Turn/Mill and Advanced 
Turn/Mill components. You do not need the 5-axis 

Simultaneous component. 

Set the B Angle on the Tool Axis tab:  
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Turn/Mill B-axis rotary example 

This example cast part has a 3D Surface feature, shown in red: 

 

The shaft on the front of the part makes it difficult to machine with 

the default angle. 

Using a 4-axis rotary strategy with the default angle, the head of 

the machine collides with the chuck, at the point marked with a pink 
arrow: 

 

Using a fixed B-angle tool axis of 45 degrees, the tool tilts over and 

avoids any collisions: 
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Use Y axis with Points List pattern (TURNMILL) 

In FeatureCAM 2013 R1, there is a new Cut feature using Y Axis 

coordinates option when cutting a point list pattern on the Z face of 

a turn/mill part:  

 

 

Previously, you could only 

rotate around the C axis, for 
example: 

 

Now you can make use of your 

turn/mill machine's ability to use 
the Y-axis. 

 

Select Cut feature using Y Axis coordinates and optionally enter a C 

Angle. 
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Import wizard (TURNMILL) 

In FeatureCAM 2013 R1, the Import wizard is available when 

importing turn/mill solids. In previous versions of FeatureCAM, the 

only alignment option was to pick a surface of revolution. Now there 
are many more options, similar to the import wizard for milling 

parts. 

The Import Results dialog now displays when you import a solid and 

you have the option to use the import wizard to align the part. 
 

AFR for SolidWorks Holes (TURNMILL) 

In FeatureCAM 2013 R1, you can recognize Turn/Mill Hole features 

from an imported SolidWorks part. FeatureCAM recognizes both 

holes on the face and around the index axis in one setup. It also 
recognizes patterns. 
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Creo 2 • 42 
Cusp control (3D HSM) • 70 
Custom colors • 20 

Index 



 

98 • Index FeatureCAM 2013 R3 What's New  

D 
Detect material thicker than • 34 
DMG FD Series • 10 
Drag select • 45 

E 
Elevation (5AS) • 79 
Expand area by • 34 

F 
Feature color • 20 
Feed distance (TURN) • 85 
Feed from start point or curve (TURN) • 

87 
Feed on curve (TURN) • 87 
File send • 25 
Finish axial allowance (3D LITE) • 8 
Finish bottom • 6 
Finish NT toolpaths • 6 
First step • 22 
Fixtures • 31 
Flutes • 19 

G 
Glass style • 16 
Grab distance (TURN) • 85 
Graphics area • 16 

H 
Hand • 19 
Handedness • 19 
Helical options • 22, 23 
Helical ramping • 22, 23 
Hide all in Setup • 24 
Hide features • 24 

I 
In to out, 3D spiral (3D HSM) • 9 
Index axis UCS • 13 
InStr • 42 
InStrRev • 42 
InterOp R23 • 42 

L 
Leave axial allowance (3D MX) • 9 
Left-hand tool • 19 
Linear approximation • 22, 23 

M 
Machine stock only • 34 
Main angle (TURN) • 85 
Matsuura CUBLEX-25 • 10 
Maximum angular correction (5AS) • 79 
Maximum ramp angle • 22 
Maximum ramp distance • 22 
Mazak Integrex e-800V II • 10 
Min. Z increment (3D HSM) • 70 
Minimum gap distance • 34 
Minimum length removed • 34 
Minimum ramp • 22 
Minimum ramp distance • 22 
Minimum Z ramp distance • 22 
Mori Seiki NMV5000 • 10 
Mori Seiki SuperMILLER 400 • 10 
Multiple start points • 58 

N 
Network database improvements • 28 
Never select this tool • 3 
NT toolpaths for finishing • 6 

O 
OD location (TURNMILL) • 41 
Okuma VTM-120YB • 10 
Override (feed, speed) • 47 
Override smoothing UCS • 79 
Override start points • 58, 74 

P 
Parasolid kernel 24.1 • 12 
Part catcher (TURN) • 85 
Part handling (TURN) • 85 
Part library • 10 
Part library format • 10 
Part support (TURN) • 85 
Plunge clearance • 22 
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Plunge feed override • 22 
Plunge points • 22 
Plunge tab • 22 
Polygonal method • 91 
Positive/negative position (5AP) • 72 
Post processor • 50 
PostCutoff (TURN) • 85 
PreCutoff (TURN) • 85 
Preferred orientation (5AP) • 72 
Probe tool group • 4 
Probe tool properties • 4 
Probing tools • 4 

R 
Ramp angle • 22 
Ramp distance • 22 
Rapid on curve (TURN) • 87 
Remove area less than (3D HSM) • 63 
Remove unsafe areas (3D HSM) • 63 
Reserved words • 50 
Reset all colors • 20 
Retract point • 22 
Reverse slug transfer (TURN) • 85 
Revolved surface boundary • 91 
Right-hand tool • 19 
Round stock • 30 
Rounding mill improvements • 3 
Roundness tolerance • 30 

S 
Scallop height (3D HSM) • 70 
Semi-finish pass (TURN) • 90 
Send part files • 25 
Shaded grey style • 16 
Show all in Setup • 24 
Show features • 24 
Show Flutes on End Mills • 19 
Show tool holder • 19 
Side liftoff angle (TURN) • 38 
Sim. speed slider • 49 
Simulation improvements • 30 
Simulation performance • 30 
Simulation speed slider • 49 
Simulation start point buttons • 24 
Slug transfer (TURN) • 85 
Smoothed (5AS) • 79 
Smoothing distance (5AS) • 76 

Snap to STL • 49 
Solid source file • 12 
SolidWorks associativity • 12 
SQL Server Express • 28 
Start curve • 58, 74 
Start point • 22 
Start point(s) (3D MX) • 74 
Stepped on surface (5AS) • 79 
Stepped with links (5AS) • 79 
STL as clamp • 48 
STL curve of revolution (TURN) • 91 
STL files • 48, 49, 91 
Stock curve finder • 12 
Stock model operation • 56 
Stock model options • 34 
Stock model rest roughing • 34 
Stock model settings • 34 
Sub angle • 85 
Sub spindle operations color • 20 
Supported (TURN) • 85 

T 
Tip-to-shoulder length • 3 
Tool axis smoothing (5AS) • 79 
Tool Manager background • 18 
Tool Manager improvements • 18 
Tool shank • 19 
Toolpath edit • 54 
Touch-off at the shoulder • 3 
Touch-off point, rounding mill • 3 
Transfers (TURN) • 85 
Transform (Toolpath feature) • 54 
Turn improvements • 37 

U 
Unigraphics NX 8.0 • 42 
Unit conversion (feed, speed) • 47 
Use axial depth of cut • 34 
Use canned cycle (TURN) • 90 
Use continuous spiral • 53 
Use depth of cut • 34 
Use new stock curve finder • 12 
Use STL as clamp • 48 
User interface improvements • 15 
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V 
Vertical mill/turn • 10 
VerticalMillTurnAddin.bas • 10 

X 
XBUILD • 50 

Z 
Z ramp clearance • 22 
Zip part files • 25 
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